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1 Introduction

AIR Space is an interactive shading and lighting interface for SiTex Graphics' AIR, TweakAIR and
BakeAIR rendering software.

With AIR Space you can import a 3D model, assign shading and lighting properties, and render final
images with AIR.

AIR Space uses TweakAIR to display a high-quality Interactive Preview Rendering (IPR) of the scene
as you adjust its shading and lighting.  You can perform many common editing functions simply by
clicking in the IPR window.

Features:

· Import model data in RenderMan RIB and Wavefront OBJ formats.

· Interactively assign materials, select shaders, and tweak shader parameters

· Interactively add, move, and tweak lights.

· Unlimited undo and redo of all shading and lighting changes.

· High-quality interactive preview, including soft shadows, antialiased textures, procedural patterns,
reflections, global illumination, and ambient occlusion

· Pickable IPR view:  click in the IPR window to select objects or materials, position & scale textures,
target lights, and more.

· Project settings stored independently of the model.  One-click re-import of a modified model,
preserving existing project settings.

· Automatic conversion of images used as textures to AIR texture maps for optimal rendering.

· Texture linking and tracking:  AIR Space automatically reconverts any texture whose source image
has changed prior to rendering.  One click refreshes textures in the IPR view.

· OpenGL 3D viewport for camera and light manipulation

· DarkTree shader support.

· Integrated asset browser for materials, textures, light sets, and DarkTree shaders.

· One-click rendering with AIR.

· Distributed rendering over multiple machines with Vortex.

2 Tutorial: Getting Started

This tutorial will take you through a series of basic shading, lighting, and rendering operations using
AIR Space with a sample 3D model. The AIR Space interactive interface uses either demo or licensed
copies of SiTex Graphics' AIR and TweakAIR.

AIR and TweakAIR communicate with AIR Space and AIR Show using a network communications
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protocol over TCP/IP sockets.  If you are running network security software or a firewall, make sure
that these programs are allowed to communicate with one another.

This tutorial is introductory rather than comprehensive. Some controls are not enabled in the demo
versions of AIR and Tweak AIR and are not demonstrated here. Some settings are given default
values and adjusted only in special circumstances. The complete manual contains more detailed
information about AIR Space.

This introductory tutorial takes less than one hour to complete. If you choose to save your work after
any section and continue later, skip to the Exiting and Resuming section for instructions.

Next Topic:  Interface Basics

2.1 Interface Basics

The AIR Space Interface

When Interactive Preview Rendering (IPR) is on, the IPR window in the upper middle portion of AIR
Space displays a high-quality preview of how the scene looks with the current lights and materials.
The IPR window can also be used to perform many editing functions, including selecting objects,
assigning materials, positioning lights, and placing patterns.
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The materials palette in the upper right part of AIR Space allows quick creation of new materials.

AIR Space's View window on the lower right displays a quick hardware-accelerated view of the
current scene.  The view window can be used to position cameras and lights.  This area also displays
the Browser window and Log window under their respective tabs.

On the left side of AIR Space under the Materials tab, the Materials window lists all materials in the
current scene and allows you to alter material parameters.

This area also displays the Lights window under the Lights tab with a list of all the lights in the
current scene and the parameters that affect the illumination cast by the currently selected light.

The left side of AIR Space also displays the Objects window and Render window under their
respective tabs.

Next Topic: Creating a New Project

2.2 Creating a New Project

Loading the Model

To begin, create a new project:

· Left click the New Project button  in the left corner of the toolbar or select New from the File
menu.

· Use the file dialog that appears to navigate to the airspace directory in your AIR installation.

· Select gettingstarted.rib by double clicking on its file name or single clicking its file name
followed by the open button.

A dialog will appear for Scene Import Options:

The default settings shown above will be used for this tutorial.
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Import Lights and Import Materials should remain unchecked.

These options allow AIR Space to import existing lights and material properties from some model
files.

View Orientation is set to Maya, Massive, SketchUp, Silo

The orientation determines which axis is up (Y or Z), which axis appears to the right in the View
window, and which axis faces forward.

Scale should remain at 1 unit = 1

AIR Space uses the scale to automatically adjust imported materials with 3D patterns to the size of
your model.

· Click OK at the bottom of the Scene Import Options dialog to create the new project.

AIR Space now loads the model and displays a wire frame view of the scene in the View window.
Notice that the materials palette has appeared above the View window.

Saving the Project

· To save the new project, left click the Save Project button  in the top toolbar or select Save from
the File menu.

AIR Space saves the project as gettingstarted.apj while preserving the original RIB file. If you
wish to name an AIR Space project file something other than the model name, you can select Save As
from the File menu and enter the preferred file name. This will allow you to create different projects
from the same model.

Although AIR Space allows unlimited undo and redo of all changes, you should save your work
frequently to ensure against accidental loss.

Next Topic: Interactive Preview Rendering

2.3 Interactive Preview Rendering

Starting IPR

One of the most useful features of AIR Space is the ability to view the effects of shading and lighting
changes immediately.  When Interactive Preview Rendering (IPR) is on, the IPR window displays a
high-quality preview of the scene with the current lights and materials.

In order for objects to be visible in the IPR window, the scene must have at least one light.

· Left click the Sky light  button in the toolbar to add a sky light to the scene.

The sky light provides illumination for your introduction to IPR.  The new light is listed on the left in the
Lights window.

· Left click the IPR start button  in the toolbar to start TweakAIR and begin Interactive Preview
Rendering (IPR).



Tutorial: Getting Started 7

© 2007 SiTex Graphics, Inc.

TweakAIR will render a high-quality preview of your scene to the IPR window.  The IPR window will
automatically update as changes to the lights and materials are made.

When using AIR Space, you will usually want IPR turned on.  Leave IPR on for the remainder of the
tutorial to observe how the rendering is affected by each step.  Some changes, such as resizing the
IPR window or repositioning the IPR camera, are displayed only after the IPR start button is re-clicked.

Additional IPR Controls

The IPR menu has items to set additional IPR properties, such as the IPR window size and the number
of processors used for IPR rendering.

· In the IPR menu, left click on Update Reflections? so that a check mark appears on the left of the
selection when the menu is open.

The IPR window will now update the shading for a surface whenever a reflected surface changes.

The IPR window has a maximum size of 400 x 300 pixels in the demo version of TweakAIR.  The full
version of TweakAIR can render previews of any size.  The registered version of TweakAIR can also
take advantage of multiple processing cores to accelerate preview rendering.  The demo version of
TweakAIR only allows use of a single core.

Next Topic: Lighting Basics

2.4 Lighting Basics

Lights

The AIR Space toolbar provides five light types:

1. A point light casts light emanating from a point in all directions

2. A spotlight casts light from a point within a cone of directions.

3. A distant light casts light along a single direction.

4. Indirect light simulates light bouncing off surfaces to provide global illumination.

5. A sky light simulates light from an illuminating hemisphere.

Undo and Redo

AIR Space provides unlimited undo and redo for all shading and lighting changes using the Undo and
Redo buttons on the main toolbar:
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As you proceed through the tutorial, use the Undo and Redo buttons to correct any mistakes, to
practice an action more than once, or to re-examine the impact of a step in the IPR window.

Removing a Light

If you completed the Interactive Preview Rendering section of this tutorial, you have already added a
sky light to the scene and will now remove it.

· Left click on the sky light listed in the Lights window on the left side of AIR Space.

· While the sky light is selected, left click the Delete button  in the main toolbar.

The IPR window now appears dark with no lights in the scene.

Adding a Distant Light

· Left click on the Distant light button  to add a distant directional light.

The IPR window should now display the scene dimly lit from the right so that the objects cast shadows

to their left.  If no image appears in the IPR window, left click the IPR start button  to make sure
IPR is on.

Moving a Light in the View Window

· Under the View tab click on Top or hit the F2 key to change from a camera view to an aerial view of
the scene.

A light can be repositioned by moving its source position, target position, or axis in the View window.
The red markings indicate the current position and direction of the distant light:

The red rectangle marks the region covered by a shadow map for a distant light.

· Left click on the small red square in the lower right of the View window to select the source of the
distant light.

· While holding down the left mouse button to keep the source selected, drag the red source square to
a position on the left of the objects in the View window.
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As you move the light, you can see the effect on the scene in the IPR window.  Once the source is
repositioned to the left of the objects, the objects should cast shadows to their right in the IPR window
as shown below:

A light's target position or axis can be moved in the same manner.  To accurately position a light, you
can switch among the Front, Top, Right, and Camera views in the View window as you make
adjustments.

Adding a Spotlight

· Left click on the Spotlight button  to add a spotlight to the scene.

The IPR window should now show more illumination and additional shadows.  The new spotlight
appears highlighted below the distant light in the Lights window.  The spotlight's source position, target
position, and axis are marked with red in the View window.  The red oval marks the outer limit of the
spotlight's cone of illumination.

Positioning a Light in the IPR Window

As an alternative to moving lights in the View window, the IPR window can be used to change a light's
position.  When using the IPR window to position a light, you may wish to temporarily disable some
lights to see the illumination cast by a single light more clearly.

· Select the distant light in the list of lights at the top of the Lights window.
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The lower portion of the Lights window displays the parameters for the distant light.

·  While the distant light is highlighted, double click inside the Illuminate all objects value box to
switch it from yes to no.

This turns off the distant light to facilitate adjustments to the spotlight within the IPR window.

· Click on the spotlight in the list of lights to select it.

The lower portion of the Lights window now displays the spotlight's parameters.

· Left click on the spotlight's Cone angle parameter.

· While the Cone angle parameter is highlighted, position the mouse pointer just below the teapot's
handle within the IPR window as shown below:

· While holding down the Alt key, left click to set the outer edge of the spotlight's illumination cone to
the mouse pointer's position.

Both the IPR window and the View window display the reduced spotlight cone.  The cone angle can
also be changed by entering the desired angle (measured in radians) in the parameter value box.

The source position and target position can also be adjusted within the IPR window using the same
mechanism:  holding down the Alt key and left clicking in the IPR window.

· Left click on the expansion button  on the left side of the Position parameter in the Lights window.

· Select the Target parameter, which is currently is set to a default position at the origin of the model's
coordinate system.

· While the spotlight's Target parameter is highlighted, position the mouse pointer on  the front of the
cup in the IPR window.

· Hold down the Alt key and left click to set the spotlight's target to the mouse pointer's position.

The change is visible in the IPR window, View window, and in the Target parameter's value box.

Setting Light Parameters

AIR Space's adjustable lighting parameters provide detailed control of illumination and shadows for
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each light in a scene.  Some parameters are common to all lights, such as intensity and light color.
Other parameters are specific to a particular type of light like the spotlight's cone angle and beam
distribution parameters.  The expansion button  to the left of some parameters reveals additional
parameters.

Double clicking on a parameter value box opens a dialog for that parameter.

For numeric parameters, the adjustment buttons  to the right of the value box decrement or
increment the parameter value.  The increment amount can be set in the parameter dialog.

Some parameters, such as colors and texture maps, provide an additional special dialog accessed by

clicking a color swatch  or small button  to the left of the displayed value.

Position

The Position parameter displays the x,y,z coordinates for the source of the light currently selected
within the list of lights.

· While the spotlight is still selected, double click on the value box for the Position parameter.

The Position dialog that opens displays the current spotlight source coordinates set to a default
position of 10 10 10.

· Enter -8 10 8 in the Position dialog's value box and click OK.

This new source position is indicated by the spotlight's red position markers in the View window. The
IPR window also displays the lighting change.

Now that the spotlight is positioned, the distant light will be turned back on.

· Inside the Lights window, click on the distant light in the list of lights.

·  Left click in the Illuminate all objects parameter value box so that it reads yes.

The IPR window again displays the distant light coming from the left.

Intensity

Light intensity can also be adjusted within a value box in the Lights window.

· While the distant light is still selected, double click inside the Intensity parameter value box.

·  Enter an intensity value of 1.7 in the Intensity dialog and click OK.

The IPR window displays the increased intensity of the distant light.

Light Color

New lights are white by default, but colors can easily be assigned for each light in AIR Space.  The
color swatches in the materials palette allow quick color selection while more detailed adjustments can
be achieved within the Color dialog.

· While the distant light remains selected, move the mouse pointer to the materials palette and right

click on the pink color swatch  in the bottom right of the palette.
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The distant light is now pink as visible in the IPR window.

· Left click on the pink color swatch displayed to the left of the Light color parameter in the Lights
window.

A Color dialog opens to adjust the light color.

· Within the Color dialog, left click on a blue color chip in the Basic colors area and click OK to change
the color of the distant light.

The blue light should now be visible in the IPR window.

Light color can also be entered within the parameter's value box.

· Left click inside the Light color parameter value box and select 1.0 1.0 1.0 to return to white light.

Shadows

AIR Space has four main shadow-casting options:

1. no shadows

2. raytrace - use ray tracing to cast shadows.
(the default setting for lights)

3. shadowmap - use a pre-rendered shadow map to cast shadows

4. automap - use ray tracing to generate a depth map for shadows during rendering

· Click on the spotlight in the list of lights to select it.

· Double click on the Shadows parameter value box that currently reads "raytrace" to view the
shadow-casting options.

· Left click on "no shadows" in the shadows dialog and click OK to select it.

The shadows cast by the spotlight in the IPR window vanish.  Notice that the spotlight's Shadows
value box contains empty quotation marks when that light is set to display no shadows.

· Click the expansion button  to the left of the Shadows parameter to view AIR Space's numerous
additional shadow parameters.

These additional shadow parameters provide fine level control of shadow effects for precise scene
lighting.  The IPR window automatically displays and updates shadows for all types of shadow-casting.

Next Topic: Materials Basics

2.5 Materials Basics

Materials

Materials determine the basic appearance of the objects in a scene.  When a new project is created,
all objects are assigned a default white matte material, unless materials were imported from the model
file.

· Left click on the Materials tab in the upper left portion of AIR Space to display the current list of
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materials in the Materials window.

· Click on the default White Matte material to display its material parameters in the left side of AIR
Space.

There are two main ways to add materials to a project:

1. Use the materials palette to create new materials

2. Add pre-made materials to the scene from the Browser window

Existing materials can also be copied and pasted to create new materials.

Creating New Materials with the Materials Palette

When a model is loaded into AIR Space, the materials palette will appear in the upper right section.
This collection of icons allows you to quickly create new materials.  A typical material has two or three
basic components:

1. The material's surface shader determines how the material reflects light.

2. The material's color attribute gives the base color for the material.

3. An optional displacement shader generates topographical features such as bumps, dents,
grooves, etc.

· Left click on the gold color swatch in the middle set of buttons .

The selected color's name, Gold, will be displayed at the top of the palette.

· Left click on the last button in the bottom row of the materials palette to select the Rippled
displacement shader.

The selected displacement shader's name, Rippled, will be added to the material's name at the top of
the palette.  If the top of the palette does not read Gold Rippled, left click again to select the correct



AIR Space14

© 2007 SiTex Graphics, Inc.

color swatch and displacement shader.

A displacement shader is not necessary for many materials, and this selection can be skipped when
creating a new material.

The buttons with spheres represent various surface shaders.  These surface shaders' names appear
at the top of the palette as the mouse pointer is held above them.

· Left click on the Metal surface shader from the top row to complete the new material: Gold
Rippled Metal.

The new material and its parameters are now listed in the Materials window on the left side of AIR
Space.

Assigning a Material to an Object

Once you've created a new material, you can use the IPR window to assign the material to objects in
the scene.

· While the new material, Gold Rippled Metal,  is highlighted in the materials list, right click on the
teapot in the IPR window.

The new material has now been assigned to the teapot.

You can also assign a material within the Objects window.

· Left click on the default null displacement shader in the lower left corner of the palette to unselect the
rippled effect.

· Use the materials palette again to create another material by left clicking on a color of your choice
and then left clicking on the Plastic surface shader in the top row.

The new material should appear highlighted in the materials list with no Displacement shader.

· While the new plastic material remains highlighted, select the Objects tab on the upper left side of
AIR Space to open the Objects window.

Three objects appear in the Objects window along with their current materials.

· In the list of objects, select the cup by left clicking on it.

Notice that the cup appears outlined in red in the View window.

· Left click the Assign Material button  below the objects list.

The cup should now be shaded with the plastic material in the IPR window, and the plastic's name
should appear by the cup in the objects list. If you do not see these changes, check that both the cup
and plastic are highlighted in their respective windows and try the Assign Material button again.

Assigning materials within the Objects window allows multiple objects to be selected and assigned the
same material at once.

· In the Edit menu, choose Select None to remove the cup's selection in the Objects window.

Modifying an Existing Material using the Materials Palette
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In addition to creating a new material, the materials palette can be used to modify an existing material.
You can apply a surface shader, color, or displacement shader to the currently selected material by
right clicking on its button.

· Left click on the Materials tab to reopen the Materials window.

· Left click on the Gold Rippled Metal in the material list.

· Right click the null displacement icon in the lower left corner of the palette to remove the rippled
displacement shader from the gold metal material.

The teapot's surface should now appear as smooth gold metal in the IPR window.

·  Click on the White Matte material in the material list to select it.

· Right click on the Planks icon  in the third row of the palette to apply the Planks surface
shader to the currently selected material.

The base in the IPR window displays the change made to its current material.

This AIR Space function provides a quick way to experiment with different "finishes" for an object.
Where possible, the newly assigned surface shader will preserve the existing color and texture maps
for the material. Modifying materials by right clicking in the palette changes their parameters without
altering the original material name.

· While the White Matte material remains highlighted, right click the Ceramic surface shader to
alter the material for the base in this scene.

· Right click on a color swatch to select a new color for this material.

When no color parameter has been selected, the color is automatically applied to the material's Color
attribute. The color can be adjusted by clicking  on the color swatch to the left of the Color value box in
the material parameters.

· Right click on the Pillowed  displacement surface shader to alter the base's material.

The IPR window should now appear similar to the picture below with the colors you selected for the
base and cup:
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Changing Material Parameters

You can modify the appearance of a material by adjusting its parameters in the Materials window in the
manner demonstrated for the lighting parameters. Some parameters are common to all materials, such
as the Color parameter.  Other parameters are specific to a particular type of material.

· Left click on the cup in the IPR window.

This action automatically selects the cup's current material in the Materials window. The material
parameters for the plastic are shown in the lower portion of the Materials window. Each parameter may
be adjusted to alter the plastic's appearance.

Additional Shaders

The materials palette displays only some of the many surface and displacement shaders included with
AIR.  The grey buttons on the right side of the Surface and Displacement value boxes within the
Materials window display lists of all the surface or displacement shaders (respectively) included with
AIR.

· While the cup's plastic material is still highlighted, left click on the grey button  on the right side
of the Displacement value box.

· Left click on VCracks and click OK.

A cracked surface appears on the cup shaded with the plastic material in the IPR window. Notice that
VCracks is now listed as the displacement shader for the plastic in the materials list.

Next Topic: Camera Basics

2.6 Camera Basics

Positioning the Camera

The View window allows you to position the camera and define the view that will be used to render your
scene.

· Under the View tab click on Camera 1 or press the F4 key to display the camera view in the View
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window.

·  On the left side of the View window  select Color from the drop-down menu to change how the
model is displayed in the View window.

Notice that the IPR window still displays a more detailed image than the View window.

When the mouse pointer is in the View window on the lower right of AIR Space, you can manipulate
the camera view in the following ways:

Rotate

Hold down the right mouse button and drag to rotate the scene around the target point.

Pan

Drag while holding down the SHIFT key and the right mouse button to pan the camera.

Zoom

Drag up and down while holding down the CTRL key and the right mouse button to zoom.

The above commands for positioning the camera are similar to those used by the Rhino modeling
program.  AIR Space also recognizes the camera positioning conventions of the Maya modeling
program:

Rotate: ALT + left mouse button
Pan:  ALT + middle mouse button
Zoom:  ALT + right mouse button

· Practice using the camera positioning commands to frame a close-up shot of the teapot in the View
window.

· Left click the IPR Start button   to see the new camera view in the IPR window.

Each time an IPR camera is repositioned the new view appears in the IPR window when the IPR Start
button is clicked.

· Left click the Undo button  in the View window until you return to the original camera
view.

· Left click the IPR Start button   to see the updated camera view in the IPR window.

Within the Front, Top, or Right views, the camera can also be repositioned by moving its source
position, target position, or axis.  In the View window, cameras are displayed in green  with their view
pyramid depicted:
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Camera position markers

Cameras can also be adjusted with the Field of View (FOV) value boxes in the View window.

Adding & Selecting Cameras

Additional cameras can be added by clicking the New Camera button in the View window.

The IPR Camera check box and Render Camera check box allow you to select the camera used for
IPR rendering and final rendering.

Next Topic: Rendering Basics

2.7 Rendering Basics

Rendering

At any time, you can render your scene with AIR. By default the rendered image will be displayed in
AIR Show, a separate program included with AIR for viewing and saving images.

· Click on the Render tab in the upper left portion of AIR Space to see the current rendering settings.

The Render window allows you to set rendering parameters such as the output image size and the
output destination.

If you are using a machine with multiple processors or multiple cores, you can set the number of
processors to use for rendering in the Render menu.  The demo version of AIR limits rendering to a
single processor.

· Left click the Render button  in the main toolbar to render the scene.

Render Region

When working on part of an image you can save time by rendering only the region of interest.  To
define the region to render, hold down the middle mouse button while dragging a rectangle in the IPR

window.  Then left click the Render Region button  in the toolbar to render the area with AIR.

IPR refreshing will also be restricted to the render region.  To reset the region to the entire image,
middle-click anywhere in the IPR window.

Next Topic: Exiting and Resuming

2.8 Exiting and Resuming

Exiting the Tutorial

When you have completed the tutorial or wish to exit and complete it later:

·  Save your work by left clicking the Save Project button .
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· Then close the project by selecting Close in the File menu or close AIR Space entirely by left

clicking  in the far upper right corner.

Resuming the Tutorial

· Restart AIR Space and select gettingstarted.apj under Open Recent in the File menu.

If the file is not visible there, use the Open Project button  or select Open in the File menu,
navigate to the airspace directory, and select gettingstarted.apj.

3 Models

AIR Space makes a basic distinction between shape and shading.  Every AIR Space project has an
associated model file that is the source for the geometric objects in the project.  The project file itself
stores all shading and lighting information.

AIR Space reads model data from the following file formats:

RenderMan® Interface Bytestream (RIB) files
Wavefront OBJ files

When you first create an AIR Space project, you will be prompted to select a source file in one of the
supported model file formats.  Depending on the file format, you may also have the option of importing
existing materials or lights from the model file.

Refreshing a Model

Once the project has been created, AIR Space stores all material and light settings independent of the
source geometry file.  If the source model changes, you can use the Refresh Model button in the
toolbar to reimport the model, preserving the project's existing lights, materials, and object properties.
If new objects have been added to the model, you will naturally have to assign those objects an
appropriate material.

Switching Models

You can use the Switch Model command in the file menu to change the model file associated with a
project at any time.  AIR Space will attempt to apply existing object properties (including material
assignments) to the new model based on object name.

3.1 Model Formats

OBJ - Wavefront

AIR Space converts polygon meshes and NURB surfaces from Wavefront OBJ files.  You may
optionally import materials and material assignments.  Material import is limited to base color, color
texture map, and approximate diffuse and specular strength.

OBJ files do not contain light or camera information.

RIB - RenderMan® Interface Bytestream

AIR Space imports all standard primitive types, including NURBs, subdivision meshes, polygon
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meshes, curves, and procedural primitives.  Some primitives may be displayed as wireframe boxes or
control cages in the 3D viewport, but they will appear properly in a rendered image.

The list of objects in a RIB files is generated by looking for the following custom attributes in the file:

Attribute "identifier" "string name" ["objectname"]

AIR Space uses the camera transformation in the RIB file as the default camera view for a new project.

You may optionally import existing lights and material properties from a RIB file.

4 IPR Parameter Picking

AIR Space uses TweakAIR to display an Interactive Preview Rendering (IPR) of the scene as you
adjust its shading and lighting.  The IPR view displays a high-quality preview of what the scene will look
like when rendered with AIR.  The IPR view also allows many editing functions to be performed simply
by clicking in the IPR window.

Start Interactive Preview Rendering

Once you have loaded or a created a project in AIR Space, you can begin interactive preview rendering
by clicking the green IPR start button.

Edit with the IPR Window

When interactive preview rendering is active, the IPR window provides the following editing functions
based on different combinations of mouse clicks:

Select a Material

Left-click a pixel to select the material at that pixel.

Select an Object

Hold down the Ctrl key while clicking with the left button to select the object at a pixel.  Hold down the
SHIFT key as well to add to the current selection instead of replacing it.

Apply a Material to an Object

Right click an object to apply the current material to that object.

Set Shader Parameters and Attributes

Several shader parameters and attributes can be set by holding down the ALT key and left-clicking in
the IPR window, after selecting the parameter in the Lights or Materials window.   "Pickable"
parameters include:

· Light source Position, Target, Cone angle, Cone delta angle, Shadow Map Width, Shadow Map
Height

· 2D texture OriginXY, RepeatXY, and SizeXY positioning parameters.  AIR Space computes the
Repeat and Size parameter values relative to the Origin values, so set the OriginXY parameter first.

· 3D pattern PatternOrigin and PatternSize parameters.  AIR Space computes the PatternSize value
based on the distance to the PatternOrigin, so set the PatternOrigin first.
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4.1 IPR Menu

The IPR menu contains commands and settings for interactive preview rendering:

Save Image As allows the current IPR image to be saved to a file.

Image Size sets the IPR image's width and height in pixels.  The IPR view must be restarted for
changes to take effect.

When the Update Reflections option is checked, TweakAIR automatically redraws a surface
whenever an object in its reflections changes.  This options slows interactive preview rendering but
results in a higher quality preview, especially in scenes with many highly reflective objects.

The Shading Override submenu allows you to override the IPR shading mode.

Max Shadow Samples and Max Reflection Samples set the maximum shadow and reflection
samples, respectively, for a single shader evalution during IPR rendering.  A low maximum allows IPR
rendering to remain interactive even when a large number of reflection samples is used by a material
or a large number of shadow samples is used by a light for final rendering.  Increase the maximum
value to improve the quality of IPR rendering at the expense of longer refresh times.

When the Smooth Edges option is checked TweakAIR smoothes object edges using a high-resolution
bitmask. Antialiasing produces smoother edges but consumes more memory and takes longer to
render.

The Processors submenu allows you to select the number of processing cores to use for IPR
rendering.

4.2 IPR Limitations

TweakAIR provides interactive updates for most shading and lighting changes in the IPR window.  The
following features will not update interactively:

· Global illumination scene sampling

· Ambient occlusion scene sampling

· Subsurface scattering

5 Lights

AIR Space provides the following basic light types:

· Point light:  casts light emanating from a point in all directions

· Directional light:  casts light along a single direction (like the sun)

· Spotlight:  casts light from a point within a cone of directions

· Indirect light: simulates illumination that bounces off other surfaces instead of coming directly from a
light source

· Sky light:  simulates incoming light from a range of directions (like an outdoor setting on a cloudy
day)
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· Area light: casts light from a rectangular surface

Creating a New Light

Create a new light by clicking on the corresponding button in the AIR Space toolbar.  The new light will
appear in the list of lights in the Lights window.  A new point light, distant light, or spotlight will also
appear in the View window.

Moving a Light

Use the View window to select and move lights.  A light can be moved using its control points or its
axis.  If interactive preview rendering is enabled, the IPR window will update as you move a light.

In a Camera view dragging a light moves in a plane parallel to the ground plane.  To change the
elevation of the light, hold down the CTRL key while dragging.

Editing Light Parameters

Use the parameter list in the Lights window to edit light parameters.

Shadows

For point lights, distant lights, and spotlights, use the edit dialog for the Shadow parameter to select a
shadow-casting method:

raytrace Trace rays from the light source to compute shadows.  For
smoother shadows increase the Shadow samples parameter
to cause AIR to cast additional rays for each shadow query.

automap Generate a depth map automatically on-demand as the
rendering progresses.

shadowmap1.sm Cast shadows using a shadow map, a special image that
stores depth values of the scene as viewed from the light
source.  AIR Space will generate the depth map in a separate
pass prior to rendering the final image.

For shadow maps and automaps the map size can be set independently for final rendering and
interactive rendering.

Diffuse Only and Specular Only Lights

By default a new point light, spotlight, or directional light contributes to both the diffuse and specular
components of illuminated objects.  A light can be made to cast only diffuse light or only specular light
by setting the corresponding light property.

5.1 Indirect Light

An indirect light simulates illumination that has been scattered by other surfaces towards the current
shading location (in contrast to light that comes directly from a light source).  A scene should have at
most one indirect light or one sky light.

Basic Attributes
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AIR computes the incoming indirect illumination at a location by casting rays over a hemisphere of
directions and recording the light reflected by each object hit by a ray.

The number of rays cast to generate an indirect illumination sample can be set independently for final
rendering and interactive preview rendering.  The Max Trace Distance attribute gives the maximum
distance to search for objects that contribute indirect illumination; shorter distances render more
quickly.  When Adaptive Sampling is enabled, AIR casts fewer rays initially and selectively casts
additional rays only in high-contrast regions for faster rendering.

The Indirect Shading attribute determines how AIR computes an object's contribution to indirect
illumination when queried by an indirect ray.  Select from the following options:

shader execute the object's surface shader

matte use a simple matte shader modulated by the
object's color

constant use the object's color only

Matte indirect shading saves time by allowing AIR to forego executing the object's surface shader.
Constant shading saves even more time by eliminating the need to illuminate the object.

Background Illumination

Use the background settings to define the indirect illumination contributed by the environment
surrounding your scene, returned by indirect rays that miss all objects in the scene.  The Background
Color gives a color to return for rays that miss all objects.  If a Background Map is supplied, AIR
treats it as an environment map giving illumination from the sky or landscape beyond the scene.

Indirect Light Caching

Because calculating indirect light at every shading location can be slow, AIR provides an efficient
caching mechanism that stores previous results and allows them to be re-used at new locations.  Two
attributes affect the quality of indirect illumination using the cache.

The Maximum Error attribute sets the maximum error that is allowed in any one estimate of the local
indirect illumination when reusing samples from the cache. Lowering the maximum error causes the
renderer to take new samples more often, producing higher quality results with longer rendering times.
When the maximum error is 0, the indirect cache is disabled, and AIR computes a new indirect value
at every shading location. The maximum error setting is the primary control for indirect caching.

The Maximum Pixel Distance attribute gives the maximum distance in pixels over which AIR will re-
use a given sample. This control ensures that at least some samples are taken in large areas with little
variation in geometry.  Larger values cause fewer samples to be taken, decreasing rendering time.
This setting should normally not be reduced significantly below the default value.

Rendering with the indirect light cache can sometimes produce splotchy artifacts as more samples are
added to the cache.  To eliminate these artifacts AIR can first take indirect samples on a separate
prepass prior to final rendering.  When the prepass is enabled, you will first see the scene rendered
with only indirect illumination, followed by a second pass with full shading.  A separate Prepass Factor
(between 0.5 and 1) scales the maximum error and maximum pixel distance values during the
prepass, producing smoother final results.
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5.2 Sky Light

A sky light simulates illumination from a surrounding light source such as an overcast sky, casting
shadows based on the ambient occlusion at a shading location.

Ambient occlusion refers to the extent to which a shading location is blocked or occluded by
surrounding objects. It provides a good estimate of the extent to which an object is "shadowed" by
surrounding objects with respect to an encompassing environment, such as the sky in an outdoor
scene. Ambient occlusion is a faster alternative to computing indirect illumination for scenes where the
soft lighting effects of hemispherical or "dome" lighting are desirable but color bleeding and bounce
lighting effects are not important.

Occlusion Sample Quality

AIR estimates ambient occlusion by casting many shadow rays distributed over the visible hemisphere
at the current shading location.  The number of rays can be set independently for final rendering and
interactive preview rendering.  The Max Trace Distance attribute gives the maximum distance to
search for occluding objects; shorter distances render more quickly.  When Adaptive Sampling is
enabled, AIR casts fewer rays initially and selectively casts additional rays only in high-contrast
regions.

Occlusion Caching

Because computing ambient occlusion at every shading location can be slow, AIR provides an efficient
caching mechanism that stores occlusion samples and allows them to be re-used at new locations.
Two attributes affect the quality of rendering with an occlusion cache.

The Maximum Error attribute sets the maximum error that is allowed in any one occlusion estimate
when reusing samples from the cache. Lowering the maximum error causes the renderer to take new
samples more often, producing high quality results with longer render times.  When the maximum error
is 0, the occlusion cache is disabled, and AIR computes a new occlusion value at every shading
location.

The Maximum Pixel Distance attribute gives the maximum distance in pixels over which AIR will re-
use a given sample. This control ensures that at least some samples are taken in large areas with little
variation in geometry.  Larger values cause fewer samples to be taken, decreasing rendering time.
This setting should normally not be reduced significantly below the default value.

Rendering with the occlusion cache can produce splotchy artifacts as more samples are added to the
cache.  To eliminate these artifacts AIR can generate occlusion samples on a separate prepass prior
to final rendering.  When the prepass is enabled, you will first see the scene rendered showing
occlusion values, followed by a second pass with full shading.  A separate Prepass Factor (between
0.5 and 1) scales the maximum error and maximum pixel distance values during the prepass,
producing smoother final results.

6 Materials

A material defines a particular appearance or look.  The material definition includes a set of shaders
and properties that tell AIR how to shade an object when it is rendered.

A material has the following components:

· A basic set of shading properties, including color and opacity.

· A surface shader that computes how the object's surface reflects light.
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· An optional displacement shader that adds topographical details such as bumps or grooves to a
surface.

· Additional attributes to customize how the renderer shades the object.

Creating a Material

There are two main ways to add materials to a project:

· Use the material palette to the right of the IPR window to create new materials

· Add pre-made materials to the scene from the Browser window

Existing materials can also be copied and pasted to create new materials.

Creating New Materials with the Material Palette

To the right of the IPR window you will see the material palette, a collection of icons for creating new
materials.  A typical material has two or three components:

· The material's surface shader determines how the material reflects light.

· The material's color attribute gives the base color for the material.

· Optionally, a displacement shader generates topographical features such as bumps, dents,
grooves, etc.

The material palette allows you to create a new material by choosing the three basic material
components:  a surface shader, a color, and (optionally) a displacement shader.

The bottom set of buttons shows several displacement shaders.  Left-click a button to select a
displacement shader.

The second set of buttons displays a standard color palette.  Left-click a color to select it.

The top set of buttons represents various surface shaders.  Left-click a surface shader button to create
a new material with the currently selected color and displacement shader.

Assigning a Material to an Object

Once you've created a new material, you can use the IPR window to assign it to objects in your scene:

Right-click an object in the IPR window to assign the current material to that object.

You can also assign a material by selecting one or more items in the Objects window and clicking the
Assign Material button.

Changing Material Parameters

You can modify the appearance of a material by adjusting its parameters in the Materials window.

Double-click on the displayed parameter value to access a dialog for editing the parameter value.

For numeric parameters, use the + and - buttons to the right of the displayed value to increment or
decrement the parameter value.  The increment amount can be set in the parameter edit dialog.

Some types of parameters, such as colors and texture maps, provide an additional special dialog



AIR Space26

© 2007 SiTex Graphics, Inc.

accessed by a small button to the left of the displayed value.

Additional Shaders

The Material Palette displays only some of the many surface and displacement shaders included with
AIR.  Click the ... button in the Surface or Displacement section of the Material window to display a list
of all the surface or displacement shaders (respectively) included with AIR.

Modifying an Existing Material using the Material Palette

In addition to creating a new material, the Material Palette can be used to modify an existing material:

Right-click on a surface icon to apply that surface shader to the currently selected material.  This action
provides a quick way to experiment with different "finishes" for an object.  Where possible, the newly
assigned surface shader will preserve the existing color and texture maps for the material.

Right-click a color icon to assign that color to the currently selected color parameter.  If no color
parameter is selected, the color will be applied to the material's base Color attribute.

Right-click a displacement icon to apply that displacement shader to the currently selected material.

Undo and Redo

AIR Space provides unlimited undo and redo for all material changes using the Undo and Redo
buttons on the main toolbar.

6.1 Surface Shaders

A surface shader computes how a surface reflects incoming light.  A typical surface shader
incorporates an illumination model that simulates a certain material type, e.g., metal, plastic, or glass,
along with one or more 2D or 3D patterns.

AIR comes with dozens of prebuilt surface shaders that you can use in your scenes.  Many more can
be found on the Internet at sites such as the RenderMan Repository (www.renderman.org).  AIR
also includes Vshade, a simple yet powerful tool for building your own shaders by connecting functional
blocks.  See the separate Vshade documentation for more information on Vshade.

Choosing a Surface Shader

The top section of the material palette to the left of the IPR window contains icons for many commonly
used surface shaders.  Left-click a surface icon to create a new material with the selected surface
shader.  Right-click an icon to apply the selected surface to the current material.

Other surface shaders can be accessed from the Materials window.   Click the button in the Surface
section of the Materials window to display a list of the surface shaders that ship with AIR.  Double-click
a shader to load it.  Select the Custom item to load a surface shader from a compiled shader file.

AIR Space displays the parameters for the loaded shader in the Surface section where they can be
edited.

Common Surface Properties

The Surface section displays a few attributes in addition to the surface shader parameters.  The Color
and Opacity controls set the values for these default attributes which are typically used by the surface
shader to compute the color and opacity of the material.
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The Shadow opacity mode determines how a surface casts shadows.  When the mode is "primitive",
AIR attenuates shadow rays based on the Opacity attribute.  When the mode is "shader", AIR executes
the surface shader and uses the computed output opacity to attenuate a shadow ray.  Primitive mode
is faster than shader mode because primitive mode doesn't require executing the surface shader for
every shadow query.

Interactive shading allows you to optimize surface evaluation by TweakAIR in the IPR view.  When
interactive shading is set to "shader", TweakAIR reruns the surface shader whenever a change is
made to a shader parameter or light source that affects the final appearance of the surface.  In "relight"
mode TweakAIR recomputes a shading result when lighting changes without re-executing the entire
surface shader, resulting in faster IPR rerendering.  This fast relight mode works with most shaders
that use only the standard illumination functions included with AIR.

If a given surface shader doesn't appear to refresh properly in the IPR window, try changing the
interactive shading mode to "shader".

6.2 Displacement Shaders

Displacement shaders add small topographical features to a surface such as bumps, wrinkles, or
dents.

Selecting a Displacement Shader

To add a displacement shader to a material, click the small button in the Displacement section of the
Materials window.  AIR Space will display a list of the displacement shaders included with AIR.  Select
a shader from the list or select Custom to load a displacement shader from a compiled shader file.

You can also use the material palette to the right of the IPR window to apply a displacement shader.
Right-click a displacement icon (in the lower section of the material palette) to apply that displacement
to the current material.

AIR Space displays the parameters for a material's displacement shader in the Materials window;
displacement parameters can be edited in the same manner as the parameters for a surface shader.

Bump Mapping vs. True Displacement

AIR offers two methods of rendering displacements:

· Bump mapping: Displacement is simulated by altering the surface normal. The surface itself does
not move.

· True displacement: The internal representation of the surface is displaced.

The two methods differ in cost and appearance.  Bump mapping is faster and uses less memory, but
silhouette edges will not exhibit displacement, and shadows will not reflect the displacement.  True
displacement is slower and potentially uses much more memory because the renderer must dice the
surface down to sub-pixel-size polygons which are then displaced.  However, truly displaced surfaces
will have appropriate silhouettes and shadows.

Displacement Attributes

The Displacement section of the Materials windows includes several displacement-related attributes in
addition to the parameters for the current displacement shader.

The True displacement attribute indicates whether AIR treats a displacement shader as a bump
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effect or actually displaces the surface.  When true displacement is enabled, you should also set the
Displacement bound attribute to the maximum distance that the shader will move the surface.  AIR
uses the displacment bound when determining when and if to generate a displaced surface.

The Trace displacement attribute determines how a truly displaced object appears to traced rays -
truly displaced or as a bump effect.  Disabling trace displacement can save time and memory because
AIR only has to store the smaller undisplaced object representation for ray-tracing, instead of the larger
representation made of many small polygons used for true displacement.

The IPR displacement attribute controls how a truly displaced object is handled in the IPR view.
When IPR Displacement is disabled, the object is rendered with displacement as a bump effect in the
IPR view, allowing you to interactively tweak displacement parameters.  When IPR Displacement is
enabled, the IPR view will show how the displaced surface will appear in the final image, but the IPR
view will not update to reflect changes in displacement parameters.

6.3 Extra Attributes and Light Linking

The bottom section of the Materials window allows additional custom attributes to be applied to a
material.  See the AIR user manual for a list and descriptions of the attributes supported by AIR.

Light Linking

AIR and AIR Space allow you to select precisely which materials are lit by each light.  Each light has a
standard illumination parameter that determines whether or not the light illuminates all objects by
default.

The default light setting can be overridden on a per-material basis.  Click the Link Light button to create
a link between the currently selected light and the currently selected material.  The initial state for the
link will be the opposite of the default light state.

6.4 Texture Maps

Many shaders allow texture maps to be used to control various aspects of a material's appearance,
including base color, specular color, opacity, and bumpiness.

Selecting Texture Maps

There are a couple ways to select a texture map.  Clicking the small special edit button to the left of the
parameter value will display a list of the available texture maps in the current project.  You can choose
an existing texture or create a new texture from a source image file.

For each texture you have the option of using the source image file directly or converting the image to
an AIR texture file for optimized rendering.

A texture map can also be selected using the integrated asset browser.  After selecting the texture
map name parameter, right-clicking a texture map in the Browser window will apply it to the current
texture parameter.

Positioning Texture Maps

Most AIR shaders include a standard set of parameters for positioning texture maps within the texture
coordinate system:

Texture size x y gives the width and height of the texture in texture space
Texture origin x y defines the location of the top, left corner of the texture map
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Texture angle gives a rotation angle in degrees

The IPR window provides a simple mechanism for setting texture size and origin:

· If the IPR window is not yet active, click the green IPR start button to begin interactive rendering.
· Select the texture origin parameter.
· Hold down the ALT key and left click in the IPR window on the desired location for the origin.
· Select the texture size parameter.
· Hold down the ALT key and left click in the IPR window at the desired location for the bottom, right

corner of the texture map.  AIR Space will compute the texture size as the difference between the
selected location and the texture origin.

AIR Space provides a streamlined version of this procedure that works for many shaders:

· Select a texture name parameter
· ALT + left click in the IPR window to set the texture origin
· ALT + right click to set the texture size relative to the origin

Texture Coordinates

By default most texture maps are applied using the standard texture coordinates assigned to a
primitive.  Some primitives such as NURB surfaces and spheres have well-defined naturaly coordinate
systems.  Primitives such as polygon meshes and subdivision surfaces need to have a texture
coordinates assigned in a modeling application if standard texture coordinates are to be used.

Many shaders also allow texture coordinates to be generated using a 3D to 2D projection, specified
with a Projection shader parameter.  AIR shaders recognize the following projection types:

st Use the default s,t texture coordinates

planar Use the x and y components of the 3D position

box Project the 3D position onto a plane orthogonal
to the x,y, or z axes based on the largest
component of the surface normal.  This
projection is useful for walls, boxes, and other
shapes with flat sides that are perpendicular to a
coordinate axis.

spherical Project the 3D position onto a sphere centered
at the origin with the poles on the z-axis.  The
"latitude" and "longitude" of the sphere are used
as the texture coordinates.

cylindrical Project the 3D position onto a cylinder wrapped
around the z axis.  The first texture coordinate is
the angle around the axis of the point (measured
counter-clockwise from the x-z plane) scaled to
the range 0-1.  The second texture coordinate is
the z component.
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6.5 3D Patterns

Some procedural shaders, such as the VGranite and VMarble surface shaders, generate 3D patterns
based on position.  AIR Space provides the following facilities for manipulating 3D patterns:

Positioning a 3D Pattern

The 3D procedural shaders included with AIR provide a Pattern origin parameter that gives an offset
for the position used to calculate the pattern.  The origin can be entered manually as X Y Z
coordinates.  You can also select the origin by holding down the ALT key and left clicking on a location
in the IPR window; AIR Space will fill in the origin with the "world" space coordinates of the selected
point.  The selected point need not be on the object with the current material applied.

Some patterns also provide a Pattern axis parameter to orient the 3D pattern.  Again, the axis can be
chosen by a left mouse button click with the ALT key held down in the IPR window.  AIR Space fills in
the axis with the surface normal.

Scaling a 3D Pattern

AIR's 3D shaders have a Pattern size parameter that determines the overall scale for the pattern.
When you create a new project in AIR Space, one of the settings is the model scale.  AIR Space uses
the model scale to automatically scale the pattern size whenever a new material is created or a
material is added to the scene from the asset browser.  This automatic mechanism allows you to build
a library of 3D materials that scale properly for any model.

The IPR window can also be used to set the pattern size.  First, select the Pattern origin parameter
and set it by ALT + left clicking on a point in the IPR view.  Then select the Pattern size parameter,
and ALT+left click another location near the position used for the origin.  AIR Space computes the
pattern size as the distance between the two points.

6.6 DarkTree Shaders

DarkTree is a visual shader creation tool from Darkling Simulations:

"DarkTree 2.0 is an advanced procedural shader authoring tool.  Its visual flow-based editor lets you
interactively create  photo-realistic procedural materials, surface shaders, and animated effects.
DarkTree 2.0 includes 100 procedural components that can be combined to generate almost any
texture or surface effect you need."

Darkling Simulations has developed a plugin for AIR that allows DarkTree shaders to be used with AIR
(the shaders created by DarkTree are not directly compatible with with shading language used by AIR).

The Darkling Simulations plugin or simbiont is included in the AIR distribution along with a few sample
DarkTree shaders.  Additional DarkTrees can be found on the Darkling Simulations website, along with
an evaluation version of the DarkTree application:

http://www.darksim.com

The Browser window provides easy access to the sample DarkTrees included with AIR:

· In the Browser window select the DarkTree Samples directory to see the sampe shaders.
· Double left-click a shader icon to create a new material with the selected DarkTree shader

AIR Space will automatically create a new material with the DarkTree shader and its associated
parameters loaded into AIR's DarkTreeSurface surface shader.

http://www.darksim.com
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DarkTree shaders can also be used for displacement effects:

· Click the small button in the Displacement section of a Material and choose the
DarkTreeDisplacement shader.

· Click the special edit button next to the DarkTreeShader parameter to display a dialog for loading
a DarkTree shader file.

7 Object Properties

The Object page allows you to select and edit the properties of individual objects.

Assigning a Material

Each object has an assigned material that determines how the object appears in a rendered image.
You can assign the currently selected material to the currently selected object(s) by clicking the Assign
Material button.

You can also use the IPR window to assign a material to an object.  Right-click on an object in the IPR
window to assign the current material to that object.

Selecting Objects

There are several ways to select objects.  The list of objects in the Objects window accepts the normal
Windows methods of selecting items in a list:

· Left-click to select a single item
· CTRL+left click to add an item to the current selection
· SHIFT+left click to select a range of items between the current item and the previous selection.

You can also select objects using the IPR window:  CTRL+left click on an object in the IPR window to
select it.  Hold down the SHIFT key as well to add the object to the current selection.

Objects can also be selected using a name pattern.  Choose Select by Name in the Edit menu to
display a dialog for entering a pattern.   All objects whose name contains the pattern text will be
selected.

8 Rendering

Rendering is the process of producing an image of your scene.  Basic rendering properties are set in
the Render menu and on the Render page.

Render Menu

The Render menu contains a few basic settings that you will likely change infrequently.

Processors:  Sets the number of processors used for rendering.

Priority:  Sets the process priority under Windows.  A low priority process will allow foreground
processes to run without being degraded by the rendering process, however a foreground process that
nevers pauses can bring background rendering to a virtual halt.

Render Page
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The Render page allows you to set properties that affect final rendering of the scene as a whole.

The top section of the page contains controls for basic rendering properties:

Image Size gives the width and height of the rendered image in pixels.

Below the Image Size control, two check boxes determine whether the rendered image is sent to a
window in AIR Show or to a file (or both).

The Channels setting determines what data is saved in the file (rgb color data or rgb data plus alpha
information) and the precision of the data (8-bit, 16-bit, or floating-point).  Note that not all file formats
support 16-bit or floating-point data.

Start Rendering

Click the Render button in the toolbar to begin rendering.

Progress of the rendering can be tracked in the Log window, which will also display any error
messages emitted by the renderer.

Additional Settings

The bottom section of the Render page holds a list of additional settings for particular features,
documented in the subsections of this chapter.

8.1 Image Quality

This section contains controls that affect overall image quality.  Use the preset list to quickly select a
quality level.

High quality images require the elimination of aliasing - artifacts in an image due to undersampling
some aspect of the scene. AIR provides extensive support for fine-tuning the sampling in a scene. The
following three commands determine overall image quality:

The Pixel Samples option determines how often the scene's geometry is sampled.

The Shading Rate attribute determines how often an object's shading is evaluated.  The shading rate
gives the area in pixels covered by a single shading sample.  A shading rate of 1 results in 1 shading
sample per pixel.   A lower shading rate of 0.25 produces 4 shading samples per pixel, which will
produce smoother shading results but require more rendering time.

The Pixel Filter option determines how individual pixel samples are combined into the final pixel color.

AIR provides independent control over the sampling of geometry and shading. This is an important
capability: for many scenes rendering time is dominated by shading calculations. With AIR you can
increase the sampling of a scene's geometry to smooth out jagged edges without increasing the
number of shading calculations.

8.2 Ray Tracing

AIR can trace rays to produce a variety of shading and lighting effects including shadows and
reflections.

Trace Bias
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Trace bias is a small value that is used to offset traced rays to prevent incorrect intersections.  If you
notice incorrect self-shadowing or incorrect self-reflection, try increasing the trace bias value.  Trace
bias is an attribute that can also be set on a per-object basis.

Traced Shadows
Traced Reflections

Use this control to enable object visibility to shadow rays or reflection rays respectively.  If your scene
does not use traced shadows or reflections, you can save memory during rendering by disabling traced
shadows and reflections.

Max Reflection Level

Sets the maximum number of "bounces" to trace reflection rays.  Setting this value to 0 will disable ray
traced reflections for the entire scene.

Background Color

The trace background color gives the color returned by rays that miss all objects in the scene (unless a
background map is provided).

Background Map

The optional background map defines an environment map that is queried by reflection rays that miss
all objects in the scene.  Map blur gives a blur factor for the map.  Map strength is a mulitplier for the
color returned by the environment map.

8.3 Background

Use the background page to select an Imager shader that is applied to the final rendered image.

To provide a background color for the rendered image, use the background imager.

To place a texture map behind the rendered image, use the Vbackdrop shader.

8.4 Atmosphere

Use the Atmosphere page to select a volume shader that is applied to the entire scene to produce
volumetric effects such as fog or smoke.

8.5 Depth of Field

Depth of field simulates the limited focal range of a physical camera.

F stop

Simulated F stop of the camera; lower values produce more blur.

Focal length

The focal length of the camera lens, in the units used for the model.  E.g, if the model is in meters, a
35mm lens would have a focal length of 0.035.

Focal distance
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Distance from the camera at which objects are most in focus.

DOF samples

The minimum number of pixel samples to use when depth of field is enabled.

8.6 Outline

The Outline section allows you to enable and configure AIR's outline rendering capability for illustration.
Note that outlines will not appear in the IPR window.

Line Width and Color

These controls set the line width in pixels and the line color.  These attributes can also be set on a per-
material or per-object basis.

Silhouette Threshold

AIR provides several methods of detecting edges for lines.  The silhouette threshold gives the
minimum difference in shading normals used to detect silhouettes within an object.  Set this value to 0
or 1 to disable normal-based silhouette edge detection.

Detect Front/Back Edges

When enabled AIR draws lines along edges that connect front- and back-facing polygons in the
rendering mesh for an object.

Depth Threshold

If greater than 0, this value is the minimum distance between points for detecting edges based on
difference in depth.

Fade Start Distance

When this value is greater than zero it gives the distance at which to begin attenuating line with based
on distance from the camera.

Min Line Width

When fading with distance is enabled, this setting gives the minimum line width in pixel.

Object Identifier

AIR will outline the border between objects with different toon id numbers.  The default identifier value
of -1 causes every geometric primitive to be assigned a unique id.  This may produce undesirable
interior lines on a single object made of several individual primitives.  Setting the default id to a positive
number will disable outlining based on object id.  You can also assign distinct ids to individual objects
or materials using the toon id attribute.

8.7 Extra Channels

In addition to saving rgb color and alpha information, AIR can save additional output values from a
rendering.

Multipass or multilayer rendering is a method of improving the efficiency and flexibility of image
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creation by rendering different attributes of a scene as separate images. Rendering in passes allows
the final image to be created by combining and fine-tuning individual passes in a compositing program
in real time without the need to re-render.

The Save extra channels toggle must be enabled to emit any extra output channels.

If Save in single file is checked, all extra output channels are written to a single file; otherwise each
channel will be saved to a separate file.  Only a few image file formats support extra output channels:
TIFF, OpenEXR, and Photoshop PSD.  A multichannel PSD file will contain one layer for each channel
with appropriate blending operations.

Most extra channels are computed by an object's surface shader.  AIR's surface shaders provide the
following output variables:

Name Description

Diffuse diffuse color

Specular specular color

Reflections reflected color

Refraction refracted color

Incandescence self-illuminated color

Many shaders further break down the diffuse component into 3 parts:

Name Description

Unshadowed diffuse unshadowed direct lighting

Shadows for diffuse shadows for direct lighting

Indirect diffuse indirect lighting

The 3 passes above can be combined to produce a diffuse layer in a compositing program:

Diffuse = Unshadowed_diffuse * (1 - Shadows) + Indirect_diffuse

You should render either the Diffuse channel or the above three channels, but not all.

Gamma Correction

When assembling an image in an image processing program, you will normally want to work with
source images in linear color space, without gamma correction, and apply any necessary gamma
correction to the final image.  To disable gamma correction, set the file output Gamma to 1.  To
prevent banding in the final image, rendering data at 16-bit or float precision is recommended.

8.8 Options and Attributes

Use this section add custom attributes and options for AIR.

A list of custom options and attributes for AIR can be found in Reference section of the AIR User
Manual.

8.9 Baking

The Baking page allows you to render or "bake" shading and lighting information to texture maps using
BakeAIR.
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For texture baking to work properly, each primitive must have a well-defined texture coordinate system.
NURB surfaces have a standard set of texture coordinates by default.  Polygon meshes must be
exported with texture coordinates from your modeler.

Baking Controls

Map base name

Gives the path and base file name for baked images.  Images can be baked to any image format
supported by AIR, but VRML files can only reference PNG and JPEG images.

Map size max

The maximum width and height in pixels of any one texture map.

Texel size

The size in world space of one pixel in an output texture map.  This value determines how densely
shading information is stored in the baked texture maps.  Larger values produce coarser shading.

Pack maps

If pack is enabled, a single texture map can hold baked information for more than one object.  When
disabled, each object will have its own baked texture map.

Bake gamma

Gamma correction to apply to the baked maps.

Bake channels

The channels to store in the baked texture maps.

Baking

Click the Bake button to start baking maps with BakeAIR.

Viewing Baked Maps

Baked texture maps can be viewed in the AIR Space View window by setting the view mode to Baked
Texture.

Exporting a Scene with Baked Shading and Lighting

Use the Export VRML button to export your model as a VRML file with references to baked texture
maps.  The resulting VRML file can be viewed in most web browsers with the aid of an appropriate
plugin.

9 Textures

Many shaders allow texture maps to be used to control the appearance of a material.  For example,
most AIR surface shaders provide texture map parameters for color (ColorMap*), opacity
(OpacityMap*), shininess (ShinyMap*), and bump-mapping (BumpMap*).



Textures 37

© 2007 SiTex Graphics, Inc.

AIR Space provides special dialogs for selecting and manipulating image files for use as texture maps.

Selecting a Texture Map

Click on the small edit button to the left of a texture map parameter to display a dialog for selecting an
image file or texture map.

If the current scene already contains texture maps, AIR Space displays a list of those maps.  Select a
map from the list, or click the new texture button to create a new texture map from an image file.

If there are no texture maps in the current scene, AIR Space displays a dialog for selecting an image
file.  Choose an image file in one of the many formats supported by AIR.  If the image file is already an
AIR texture map, AIR Space uses that file as-is.  For other image files, AIR Space displays a Texture
Conversion dialog for converting the image to an AIR texture map for optimized rendering.

Texture Tracking and Updating

AIR Space maintains a list of all texture maps used in the scene, including links to the source image
files.  Prior to starting a rendering process, AIR Space  automatically re-converts any texture maps
whose source image files have been modified.  AIR Space generates a new texture map name each
time an image file is re-converted, to avoid conflicts with any rendering processes in progress.

Because AIR Space automatically tracks and re-converts textures, you can freely alter a source image
without having to change the texture map settings in AIR Space.  AIR Space does not automatically
update an active IPR image when a source image changes.  You can force AIR Space to re-convert
changed textures and refresh the IPR view by clicking the Refresh Textures button in the toolbar.

10 Views

Use the 3D viewport in the View window to position cameras and lights.

Viewport Manipulation

AIR Space supports both Maya and Rhino conventions for viewport manipulation:

Maya Conventions:

Rotate - Alt + LMB
Zoom - Alt + RMB drag up and down
Pan - Alt + MMB

Rhino Conventions:

Rotate - RMB
Zoom - Ctrl + RMB
Pan - Shift + RMB, and RMB only in orthographic views

Selecting and Moving Lights

A positional light can be selected and moved by left-clicking on either of its control points or on its axis
and dragging the light to a new position.

The indirect and sky lights have no position and are not displayed in the View window.

Selecting Objects and Materials
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Objects and materials cannot be selected in the View window.  Use the IPR window instead.

11 Browser

Use the Browser window to view, store, and load assets, including:

· Materials
· Light sets
· Image files for texture maps
· Dark Tree shaders

The left-hand side of the Browser window lists directories that have been registered with the browser.
Select a directory to view its contents.  You can add a new external or child directory using the Browser
menu.

The right-hand side of the browser displays small "thumbnail" views of any assets in the currently
selected directory.

Using Materials

Double left-click a material thumbnail to add the material to the current project.

Right click a material thumbnail to apply a material's properties to the currently selected project
material.

Storing Materials

To store a material in the browser, choose the destination directory in the browser, select the material,
and click the Copy to Browser button in the AIR Space toolbar.

Applying Images as Texture Maps

The AIR Space browser will automatically generate thumbnail previews for all image files supported by
AIR.  Right click an image to apply it as a texture map to a currently selected texture parameter in the
Materials, Lights, or Render window.  AIR Space will convert the image file to an AIR texture map for
rendering (unless the image is already an AIR texture map), and store a link between the source image
and the texture map.  You can modify the way the image is converted by editing the texture parameter.

Using Saved Lights

Double left-click a light set thumbnail to add the lights in the set to the current project.

Storing Lights

You can store one or more selected lights as a light set by clicking the Copy to Browser button.

Thumbnail Size

Thumbnail size can be changed in the Browser menu.  After changing the thumbnail size, select
Refresh Thumbnails to generate preview images at the new size.

Browser Storage

The directories displayed in the browser are simply directories on a storage device, and each asset is a
file.  Thumbnail images for a directory are stored in an air_thumbs subdirectory.



Distributed Rendering 39

© 2007 SiTex Graphics, Inc.

12 Distributed Rendering

AIR Space provides a simple method of distributing the rendering of a single image over multiple
computers.

The model and project files must reside on a networked driver accessible to all machines that will be
used for rendering under the same driver letter.  Any custom shaders or pre-converted textures must
also reside on a shared drive.

To make a computer available for distributed rendering, start AIR Space, and select Start Voluntair in
the Tools menu with the appropriate number of processors for the machine.  Voluntair is a small
program that runs in the background, waiting to receive messages from the Vortex distributed
rendering application.  AIR Space can then be closed on machines that will not be used for modeling.

To enable distributed rendering in AIR Space, check Use Vortex in the Render menu.  With Vortex
enabled,  AIR Space calls Vortex whenever you begin rendering.  Vortex distributes tiles of an image
among all available rendering clients (those machines running Voluntair) for rendering with AIR and
assembles the pieces into a final image.  Vortex works with all available display drivers and image
output options, including shadow maps.

An AIR license is required for each machine used for distributed rendering.

13 Animation

The Animation section of the Render tab can be used to perform 3 basic types of animation.  When
Animation is enabled using any of the 3 modes, the Render Animation button in the toolbar can be
used to start rendering the animation.

File Sequence

AIR Space can apply the current shading and lighting setup to a numbered sequence of model files.
The frame number should appear between the base name and the file name extension.  E.g.,

sphere.1.rib
sphere.2.rib
sphere.3.rib

The frame number may be preceded by leading zeroes.

To render multiple frames, check the File Sequence control on the Render page and enter the frame
range as, e.g.,

1-3

Turntable

A turntable animation simply rotates the model about "up" axis through the origin.  Check the
Turntable control to gain access to the following options:

Frame count:  number of frames in the finished animation.

Max angle:  maximum angle in degrees to rotate the model.

Sub range:  allows you to restrict the animation to a sub-range of the total sequence.  The first frame is
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frame 0.

Click the Preview button to see the animation previewed in the View window at the rate specified in the
adjoining frames-per-second (fps) control.

Camera Path

A camera path animation moves the camera along a path defined by the current render camera and
the next N cameras in the View list, where N is the number of Segments in the path.  Camera Path
controls:

Frame count:  number of frames in the finished animation.

Segments:  the number of cameras after the Render camera that define the path.

Sub range:  allows you to restrict the animation to a sub-range of the total sequence.  The first frame is
frame 0.

Click the Preview button to see the animation previewed in the View window at the rate specified in the
adjoining frames-per-second (fps) control.
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